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1. Introduction

In Search of a Comedy was commissioned by Sibelius Soft-
ware Australia for the launch of Sibelius 5. Sibelius asked
well-known jazz and film composer Paul Grabowsky to
write an entertaining piece that could be used in two ways:
firstly, as a showy opener to the Sibelius launches in Perth,
Sydney, Melbourne, Brisbane, Adelaide, Hobart, Launceston
and Canberra featuring live solo violinist accompanied by
the new highly realistic Sibelius Sounds Essentials (which
were a major new feature of Sibelius 5).

The second requirement of the piece was to make it adapt-
able for an education kit specially designed for all English
speaking countries. And that's the kit that you're holding
now. The idea of this kit was to produce a series of lesson
plans each concentrating on a musical concept or related
concepts which each led to composition tasks for students
which could be completed in Sibelius. The kit is free.

As well as this booklet, the kit includes a CD-Rom (or alter-
natively you may have downloaded these resources from
the Sibelius website). On the CD-Rom you'll find work-
sheets to get your students started on the composition
tasks, and the Sibelius file of the original composition.

Sibelius 5

When you open In Search of a Comedy, Sibelius may tell
you that it can't locate a video file called Grabowsky Solo
Violin. This is included in the same folder as the Sibelius
file, so you should be able to easily locate it. In actual fact
this file is the solo violin part, recorded live so that you have
the same experience of Sibelius’ playback with a real solo-
ist. To get the best playback results, make sure your com-
puter has 1Gb or more of RAM and that you've installed
Sibelius Sounds Essentials.
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[Introduction cont.]

Because everybody’s computer system is different, you may
find you need to make a few adjustments to balance the
solo violin and the orchestra. If the solo violin needs to be
louder, open the video window if it isn't already (Window
> Video) and slide the volume slider all the way to the
right. If the violin still isnt loud enough, you can turn Si-
belius’ playback down in the mixer (shortcut M) — change
the Master Volume at the very bottom of the mixer (if it
doesn't appear, there’s a button to show or hide it at the
top of the mixer).

Finally, if the violin plays slightly ahead or behind the score,
you can edit the starting position by going to Play > Video
and Time > Timecode and Duration. Under Start Video
At: Sibelius will be set to -0:00:00:17. If the violin sounds
behind the orchestra, try a lower number than 17. If it's
ahead, try a higher number. And if you have any problems
getting it to play back just perfectly, there's an MP3 of the
whole piece on the CD-Rom or on the website if you have
downloaded this resource.

2. About Paul Grabowsky

It's hard to describe what Paul Grabowsky ‘does’ in one
introductory sentence. Paul is the artistic director of the
Australian Art Orchestra, a film composer, performs regu-
larly with his trio, with other renowned soloists and large
ensembles around Australia and all over the world, is regu-
larly asked to speak as a music expert and educator, and
often has a bunch of ‘side’ projects on the go at any one
time.

Paul is a classically trained pianist but his focus and his love
is jazz. It's impossible to pigeon hole Paul, though, because
his output is so wide and varied, from the avant garde
through the Hollywood film set to a humourous entertain-
ing spectacular like In Search of a Comedy.

Paul has a CV most musicians would kill for. Countless
ARIA and AFl awards and nominations for films like The
Good Looker or Jessica, ARIA awards for his albums, Rolling
Stone Jazz Artist of the Year twice, the Sidney Myer, Bell
and Helpmann awards and the Melbourne Prize for music
to name but a few. Paul has written for or performed as
part of Michael Kieran Harvey, the James Morrison quartet,
the Sydney Olympics and Paralympics, Don Burrows, Katie
Noonan, Branford Marsalis and many many more. He has
performed all over the world.

On his website, Paul describes his attraction to jazz as such:

My love affair with jazz started at the time when most first
serious love dffairs start, namely at 16. My school, Wesley
College, was one of the few at the time to boast a jazz en-
semble and not being a sportsman it was possibly the only
school activity that | could pursue which might attract the
attention of the opposite sex. | couldn't play jazz to save my
life but largely thanks to the encouragement of John Lee,
the teacher in charge of the group, | persevered. Every
night, Monday to Friday, | would listen to the ABC's radio
show "Music to Midnight", which introduced me to a host of

Sibelius

Timecode and Duration

Start Time

Timecode of first bar GD—O—OUUO_C:

Startvideo at: (7 start of score

in score

Start video from: into video
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Duration /_‘: 24

[ Duration at end of score Oz
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The Timecode and Duration dialog in Sibelius
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[About Paul Grabowsky]

mainstream artists, such as Oscar Peterson and Errol Gar-
ner. It didn't take long before | realized that jazz was the
music that | was destined to play. | think it was the mar-
riage of rhythm and line that swept me away. Exposure to
be-bop turned my head around, and | began to transcribe
various solos by Charlie Parker, Fats Navarro and Bud Pow-
ell. Bud is still my favourite jazz pianist.

Paul is also an avid user of Sibelius, which is another reason
his name was the first considered when the idea of this
commission came up. When Paul became involved in the
release of Sibelius 5 and saw the product early, he said “

Bibliography and further reading:

http://www.paulgrabowsky.com/
http://www.aao.com.au/
http://en.wikipedia.org/wiki/Paul_Grabowsky

3. Paul on Sibelius 5

“Whether composing scores for a large film orchestra, or
writing contemporary jazz for the Australian Art Orchestra,
Sibelius has all the tools | need. Its easy to learn, and re-
mains the most powerful notation package available today.”

Paul Grabowsky
August 2007

4. Using the Ideas Hub in the provided compo-
sition tasks

Included in the CD-Rom or from the website where you
downloaded these files is a folder of Sibelius 5 scores
which are composition task worksheets to get students
started on the tasks based on studied musical concepts.

The Ideas Hub

To get students started in each task, basic musical elements
(chords, ostinati, accompanying parts, and so on) are in-
cluded in the Ideas Hub. By default, the usual library of over
2000 ideas is turned off in each of these scores, so students
will focus on the relevant material only. Instructions for
each task are also included on the first page of each score,
so that students can move seamlessly from the listening
lessons on In Search of a Comedy to the composition task
with little Sibelius experience.

Professional Development & Training

If you haven't used the Ideas Hub before, it might be worth
learning how it works. The following pages are from the
Sibelius 110 course which can be taken with any Sibelius
Training Partner (see www.sibelius.com/training).
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Capturing and Sorting Your Own Ideas

Whilst you're working on a score, open the Ideas Window,
by going to Window > Ideas, or clicking on the Ideas but-
ton on the Toolbar (it looks like a light bulb). Click on the
Score button at the top. You should have an empty win-
dow ready for you to fill with your own ideas.

An idea can be a passage of music of any length, any kind
and for any number of instruments. To capture an idea,
select the relevant bars, notes or musical elements in your
score and then press Shift + I or &+l. You can also click on
the Capture Idea button at the bottom of the Ideas window.
The idea will now appear in your collection of Score ideas.
You'll have noticed that Sibelius automatically “tagged” your
idea with a few pieces of information including a title, the
time signature and the speed at which the idea was cre-
ated.

To make your idea easy to locate down the track, you can
add your own tags and even colour-code your ideas. Select
an idea in the Ideas Window and click on the Edit Idea Info
button at the bottom of the window. You can give your
idea a more descriptive title in the Name box and then add
some “tag” words (separated by spaces) in the Tags field
(such as fast, funky, 12 bar blues). If you'd like to give your
idea a special colour, click on the Color button and choose
away!

Editing Ideas

If you would like to edit the musical content of an idea, you
can select it and then click on the Edit button at the bottom
of the window, or just double-click it. You can then change
the notes, tempo, harmony or instruments just as you
would edit any score. Save the changes and close the idea
to return to your score.

Sibelius 5 comes with over 2000 copyright-free ideas, ready
to use as a springboard for compositions or arrangements.
The ideas represent a huge range of styles - from classical,
jazz and band to world music rock and hip-hop.

To access the collection, click on the Library button at the
top of the Ideas window. A list of ideas will appear, each
with a different colour to match a specific style of music.
You can search the library by typing tag words into the
search field at the top of the window. Try Motown, funk,
classical, jazz blues or even words like happy or slow.

Sibelius
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-

[ Score ey Library All
Mr. Bean 4

")g ';: ;: | .h.: : E

L] - 4 - .
4/4 - = 93bpm
Mr. Bean 3 :

Fh- 1 mmmg| 1 112

4 e # :
Gt -

4/4 e 3bpm
Mr. Bean 2

£ L LT ]

( & Y I l o e

- } i o

et Lo
a4 S 126bpm
Mrr. Bean 1

a8 178 |

L]
414 76bpm

® QQ gl A

The Ideas Hub with some of the Mr Bean ideas in it

Edit Idea Info

Edit Idea Info

Name: | lazz Electric Guitar Rhythm §

Tags: Accompaniment Beat Blues Country Major
Medium Mid-tempo Minor Moderate
Maderato Pattern Pulse Rhythmic
Rhythmical

——
( color... )
Key: G majo
Time signature: 4/4
Tempo: 120

Number of bars: 12

Instruments; Electeic Cult

Date created: 11/06/07 18:55
Date modified: *1/U

Location; Libra

_ Cancel oK

The Edit Idea Info dialog box
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Listening to Ideas

Sibelius

You can check how an idea sounds at any time by clicking e Ideas .
and holding the mouse button on it. The idea will play back )
in a loop until you release the mouse button. Clsco 0 Libmny Al
Detailed View Motown Rhodes Rhythm 5 i
_ _ _ , GE T e
The Ideas Window has two views: compact (which we've . $$s £ 335 2 s
been using up to this point) and detailed. To switch to the i A 3tpe
. ; . . totowr h
Detailed View, click on the button on the bottom right-hand WEO:: Fhw_'e‘{’,_“ fhm 2 - C .
corner of the Ideas window. 4‘ R R g:L..:ai = =
: 2= le—2—=s F
4/4 A 115bpm
Detailed view allows you to see a complete notation pre- Motown Rhodes Rhythm 3 L
view of an idea as well as all the tags belonging to each L, M-y | i
. (o B - R H
ldea. . = -——="_ v = - L
4/4 115bpm
Detailed view also gives you access to the Export or Import piStowY Kipres Ryt 10 -
b hich all h ideas with oth Gt LT YT e T
uttons which allow you to share your ideas with other CH R =SS ] H
people, or transfer them to other scores. For more informa- 4/4 115bpm 4
tion, see Sharing Ideas and Importing Ideas in Help > Ref- Motown Rhodes Rhythm 1 LY

erence > 5.8 Ideas.

® QA @@ fz @

Some of the built-in Ideas in the Ideas Hub

800 Ideas
Filter drums -l () Score O Library @ all
Name Tags Key Time Tempo Instru Bars Create Modifi Location
ip 3 ajo 4 : 7 3 0
Marc... Acco. C major 4/4 180 Marc 8 11/0... 11/0... Library
Marc... Acco... Cmajor 3/4 108 Marc... 4 11/0... 11/0... Library
Gara... Acco... Cmajor 4/4 135 Drum... 4 11/0... 11/0... Library
Gara... Acco C major 4/4 135 Drum... 4 11/0... 11/0... Library
Gara... Acco... Cmajor 4/4 135 Drum... 4 11/0... 11/0... Library -
Cara  Aren C mainr 414 138 Mrum 1 1140 1140 lihrarv b |

LOLRLRC] 0 ER LR
= it E i L

_ — i
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The detailed view
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5. Music Concepts and Composition Tasks: Pitch

Parallel chords
The opening section (bars 1 to 16) repeats the same two
bar chord progression 8 times. This chord progressions is
repeated at bar 37 and 95 although transposed down a
perfect fifth to begin
with a C major chord.

v r 3 3 o o "3 o & il ol 2 3

Listen to each occur- 9 . £ — — £ -IF- -IP- FEr o ® 1 . e e i i

rence of this pattern, [ [ < C ——— = C i

or listen through the g%

whole work and ask

your students to iden- f'l _ - P — o _ e - & _ _

tify where it returns. (" ) P 7 7

fy G R e e
.) — V H | J k . |  —

Unconventional harmony Chord progression bars 1 to 16

The two-bar chord pattern is unconventional in that all
chords are major chords and move in entirely parallel
movement, and that while they have a clear tonal centre of
G each chord is not part of one key or mode. It is the paral-
lel movement and the tonal centre which lend an immedi-
ate musical familiarity to the listener.

Review the difference between major and minor chords. If
you can do the following keyboard exercise, make sure that
they understand that even though all chords are major the
similarity is in the intervals between notes of the chord, not
combination of white and black notes, which can confuse
some students.

Internalising the theory through keyboard skills

If you have access to multiple keyboards or pianos, ask
each student to learn the chord progression. For those who
do not have much keyboard experience, teach them how to
play the progression one-handed in second inversion
(which maintains the same top pitch). The parallel move-
ment of the hand will help them

internalise what is going on in A — o

the harmony. w = %,7 e N e N ’Tﬁl-;_ligg = Eﬁ@

Further listening

Point out that while the progression does not follow con-
ventional harmonic rules students that the students may
have learned, it does most certainly have a tonal centre
which is G (and C on its latter repeats). Listen again to the
whole opening and observe the drones on G and D in the
marimba and harp parts, followed by the addition of the
bass part which also revolves around G and D.

1’8 JuswdoldAs( JeuoIssajo.d
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The chord progression one-handed

Composition task

The composition task is for students to write a chord pro-
gression of their own with parallel harmony. They do not
necessarily need to use major chords — minor chords or any
other chord with three or more notes in it is fine, and
chords may be in any voicing and for any instrumentation.
In the Ideas Hub of the score GrabPitch.sib chords with
varying rhythms are provided to give students a start. They
can invent their own chords, or they can use one from the
Ideas Hub and transpose it to create a chord progression.
An extension to the task is to add unpitched percussion
parts and one or more melodic parts.

www.sibelius.com/training
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6. Music Concepts and Composition Tasks: Meter, Tempo and Rhythm

Paul Grabowsky does incredibly clever things with Meter,
Tempo and Rhythm in In Search of a Comedy. Although the

6
time signature for the majority of the piece shows as 4 ,
12 12 3
8 . 8 2
the meters of compound , additive s, and
6 3

composite 8 + 4 are implicit in the rhythmic writing. In
addition to that, the rhythms are syncopated over any writ-
ten or implicit meter, making the whole piece sound rhyth-
mically distorted and exciting. So what does all that mean?
Let's look at some different sections of the work and what
happens with meter, tempo and rhythm within them.

YR L O e Y s Y B
¢ PR S I ..

The opening is written in = but has much more of a
feel with four beats to the bar, and the strong beat on beat
1. Play the introduction and clap the 4 beats. Show the stu-

12 6

dents how quavers are grouped in as opposed to 4 ,
explaining the concept of compound and simple meters if
necessary; and then show them the written rhythm of the
ostinato that begins in the piano then moves to the strings,
the woodwind and finally the trumpets and clarinet. Ob-
serve that it's actually much more difficult to clap 6 than 4

12 6
4

in this section and that this tells us it's in 8 not ~ :tryit

The opening, bars 1to 16

Different subdivisions of 6/4 and 12/8

The rhythm of the repeated chord pattern is one bar long
and can be seen to the right. Each bar has an accent cre- H ll% J Y J J Y J J i J J J J |
ated by the changing notes on what would be the final two

6 The rhythm of the repeated pattern

beats of a 4 bar. In this context, it's possible to hear this

s 3 6. .3
rhythm as a combined + bar. When we look at (8 and 4)
later sections of this piece we will find that this composite

meter is often suggested by the rhythmic grouping of the ﬂ_lg_J_‘z_J_J_‘]_J_J_J_J_J_J—J_'
notes. It's possible to hear the opening either way, though;

6

and being written in 4 the whole section has an obscured
meter, which is Grabowsky's intention and creates excite-
ment and edginess.

Professional Development & Training

Rhythm grouped as composite 6/8 and 3/4

Wider listening
Flamenco is a Spanish music and dance form which also

6 3

often uses alternating 8 + 4 time signatures. Listen to
some Spanish Flamenco, or you may find that students find
more approachable America from Leonard Bernstein’'s West
Side Story which is rhythmically modelled on this style.

www.sibelius.com/training
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[Meter, Tempo and Rhythm]

Back to the opening

Now look at the bass part in this section, entering at bar 9.
Whether the meter is compound or simple, the bass part
obscures it further by syncopating over the beat of either! It >
does, however, back up the feeling of a crotchet beat at the _6\/
end of the bar by doubling the crotchet rhythm.

TTT®

(R o8
13

The bass line

Second section (and main theme), bars 17 to 33
Following the bass and lower string parts is the key to fol-
lowing the subdivisions here. Again, while the key signature

6
is 4 we don't hear six even crotchets in a bar. Again, the

6 3

bass line rhythm fits most closely an alternating 8 + 4
The upper strings play pizzicato off-beat chords, which fur-
ther syncopate over the already obscure metric divisions.
Try clapping the 1-2-1-2-3 along with the bass line — you
can highlight just the bass line to hear it alone.

From bar 29 to 32 there is a transition into the third section

6

which again although written in 4 has a different feel. In
this case, the bar is divided into 3, with the punctuation of
the chords in addition to the phrasing in the solo violin and

3
2

flute confirming three strong beats in the bar: therefore

Tempo

From the beginning to this point there hasn't been a written
tempo change, but because the length of the beat has
changed (so far one beat has been 2, 3 and 4 quavers long)
the tempo effectively changes with each change in feel. The

3
implied 2 is therefore slower, but is there so briefly the
ear struggles to comprehend exactly what has happened
(again, this is Grabowsky’s intent).

1’8 JuswdoldAs( JeuoIssajo.d
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Third section bars 33 to 37, and fourth section bars 37 to
In this section we hear for the first time simple quaver
rhythm from both soloist and accompaniment that might

6

actually suggest a regular 4 . Before it can establish itself,

however, we move into the next section 6 .3

where the opening chord progression, (Saﬂd4)

transposed down a fifth, appears in the

piano at the same time the accompani- —H—%—J—‘/—J—J—:’—J—J—?’—J—J—J—J—‘—J—V—J—J—\/—J—D—D—D—{

ment to the main theme (which enters

Another way of reading the 2 bar pattern

6
four bars later on the clarinet) gives it a much more 8 +
3 12
4

than 8 feel. And just when you might think that was

www.sibelius.com/training
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[Meter, Tempo and Rhythm]

creating enough rhythmic interest, Grabowsky gives the solo
violin accompanying quavers which change pitch every sec-

6

ond note, giving a straight 4 feel again. At no moment is
anything allowed to settle. At bar 49 this turns into arpeg-
giated 4s, but not regularly through the bar, and with rests
so that where they begin soon becomes syncopated with
the accompaniment too.

The rest of the piece
Students may want to explore the rest of the piece, which is
just as rich with changing inferred meters and syncopated

9
rhythms. The main points of interest would be the 8 bars
3
at 53 to 56 and again at 111 to 118; the slow 2 feel at

bar 57, the increasing level of syncopation as the solo part

12

develops; the additive 8 rhythms from bar 79 (for in-
stance, 3+2+2+2+3); and the recapitulation of much con-
trasting rhythmic material from bar 95.

Composition task

Write a short piece which uses a mix of compound and
simple time. This may be done freely, or to get you started
two Sibelius templates have been provided. The first one,
GrabMeter1.sib is a blank percussion file with alternating

6 3

8 + 4 time signatures. In the Ideas Hub, you'll find per-
cussion parts that fit to this pattern. Choose two or more,
and add at least two parts of your own, on pitched or un-
pitched instruments.

The second file provided, GrabMeter2.sib, is again a blank
score but this time with ideas in the Ideas Hub which divide

6

a 4 time signature in different ways, like
the Grabowsky. The ideas include bass
lines and unpitched percussion instru-
ments. Choose one of each kind of idea,
and repeat it as an ostinato. Then add at
least two ideas of your own, one pitched
and one unpitched, which deliberately
obscure the implied meter of the idea
you originally selected.

Professional Development & Training

Instructions for each task are also pro-
vided for your students in the Sibelius
files.
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7. Music Concepts and Composition Tasks: Dynamics and Expressive Techniques

The solo violin part can be opened and

printed from within the Sibelius score by B8N0 Sibelius Instruments
clicking on the parts drop-down menu
and choosing the solo violin part. It can {{/M String sul ponticello and sul tasto
also be found in the worksheets folder
as a PDF ready for printing or sharing i Sul ponticello
electronica”y. In the recordings fOldel' ) (— A mysterious, glassy sound produced by bowing near to the bridge.
you will also find an MP3 of the entire u{l ; Rimsky-Korsakov, Scheherezade, 3rd mvt
violin part, and a series of excepts which ‘}'ﬁl é; == o —— e
7 ) - — 2 | i _— — - e
match the examples below. & g____ =E==C"=C = ——
. . T . — [¥][®] normal
The virtuosic violin part is an excellent éﬁ P e - (] ot see
. - -
opportunity to study expressive tech- ¢
niques available to a string player, as @ T

well as bowing technique and creation
of contrast through dynamic change.
You may like to augment this with some W Sometimes 'sul tasto’ is written by composers only as a suggestion for the desired sound and it is left up

. ! ) ; to the player to decide how to produce it
wider listening to examples of other
string instruments performing the same
bowing techniques and examples of
extended techniques, which are not
used in In Search of a Comedy. Able
string students or peripatetic teachers : '
may be able to demonstrate; another - ® O L i
solution is a program made by Sibelius
called Instruments which includes hun-
dreds of such examples as score ex-
cerpts and live recordings.

) | A softer, duller tone preduced by bowing over the finger-board. This werks best on the lower strings
frif of each instrument.

Content in Sibelius Instruments

Here are examples of different bowing techniques and
sounds:

Separate bows (Détaché)
Where there is no bowing instruction or implicit articulation,
each note is played with a separate bowing — alternatively

1’8 JuswdoldAs( JeuoIssajo.d

up then down. The symbol for an up bow is V" and a down

bow is . When each note is bowed separately it has
more attack, and the passage will not be as smooth, even if
there are no rests between notes. One example of this is at
bars 92 and 93: while much of what is separately bowed
throughout the work

is marked staccato, - o £ .
even the notes that % b — _b"'

Suiuiel

y - ) | —
are not here have a e —
very clear attack: \!—"‘J’ e —

mf cresc. f
(Recording Grabowsky solo ex1 bars 92-93.mp3) Separate bows

www.sibelius.com/training
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[Dynamics and Expressive Techniques]

Slurred bows
In string music, a slur indicates that the notes affected
should be played in the same bow. This creates a legato
phrase. In the main theme Grabowsky likes to contrast
slurred  groups of
notes with staccato
notes. In the second
half of the phrase
(bars 21 to 24), many
notes are slurred, and
as a result the melody
is much smoother:

Bars 21 to 24, solo violin part

(Recording Grabowsky solo ex2 bars 21-24.mp3)

Fast, Loud, Staccato (Martelé)

An effect used in many passages in In Search of a Comedy,
writing in this style requires the performer to grip the string
with the bow, mo-
mentarily  stopping
the sound Dbefore =
proceeding. Because =
the string is fully mf
damped at each
preparation this
achieves a strong
separation between
notes. A good exam-
ple of this is the pas-
sage from bar 58 to
75:

&,

L
¥

-‘;%
Fde

I

Solo violin bars 58 onward

(Recording Grabowsky solo ex3 bars 58-75.mp3)

Spiccato

Grabowsky uses spiccato especially between bars 78 and
86 and later between bars 99 and 105. Spiccato is a tech-
nique in which the bow is ‘thrown’ onto the string so that
it bounces off again. Each successive note uses a different
bow direction. The technique has a light, crisp effect and
works best at quicker tempi.

VY AaVYAaVYaAaVaVY AV VAV smn

(Recording Grabowsky solo ex4 bars 78-86.mp3) Solo violin bars 78-83
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[Dynamics and Expressive Techniques]

Dynamic contrast
It's not just articulation that directs the expressive tech-
niques the violinist employs. The dynamics and placement
of contrasting dynamics will also affect the choice of attack
and mode of bowing.
In the final section of
the piece, as part of
the build, Grabowsky
brings the solo violin
in at bar 99 marked p,
and crescendos poco
a poco (little by little)
as the excitement
rises, with spiccato
bowing building to

T e i i et e

arpeggiations at bar -

107 marked f, which £

then build in dynamic = = -

further with the use of W —— % igﬁ y — g —F ;13; T 'k\:'f' va i N7 e a— ! = i
accents from bar 111 =& = =~ & = ¥ 7 ; ﬁ:li— 7 b } ]
and the very fast s ‘hi L T,

slurred_ notes in the a2z - _ L E'EfELe i®he . =

penultimate bar. Eve- ?' e e L o e : = i

ryth|ng WOI"kS to- < " 'r) y— - y — Ig i Jg | o - | —

gether to create a b/ /ﬁf’ T

final climax y  aBamia , eettefeesfecaferefol 2

l__3___|L_3.-—| —y— —gdl—gdl_3g3Jdl_3gdl_gd
Varied attach and dynamics in the solo violin part

(Recording Grabowsky solo ex5 bars 100-120.mp3)

Composition task
Students will write a piece for solo violin (any other instru-
mentation in addition is allowed) using at least one of the
above expressive techniques or one of the following tech-
niques and extended techniques which you may have also
studied in class:

Sul tasto

Sul ponticello

Snap pizz. (Bartok pizz.)
Glissando

Col legno

Harmonics

Tremolo

Multiple stops

Reference to each performance technique is found in the
Ideas Hub to help the students remember what they have
learned in class.

The piece should be a musical description of a life experi-
ence. They may imitate the sound of that experience or
write descriptively about their feelings about it. For exam-
ple, the piece may be about a visit to the dentist or their
first day at high school (lots of tremolo!), or about a trip on
an aeroplane, or a recent holiday. Open GrabExpress.sib to
begin.

www.sibelius.com/training
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8. Music Concepts and Composition Tasks: Tone Colour

In Search of a comedy is a work for solo violin and orches-
tra. It's probably not quite the style of piece you'd associate
with these forces, however, and Grabowsky has extended
the instrumentation to include instruments you might nor-
mally expect to find in the orchestra but which do reflect
the jazz background that is his main artistic focus.

With a copies of the score or at the computer, ask students
to find instruments that they think are not typical to an or-

chestra. You will expect them to name the drum kit and the h i
jazz bass. They may also nominate some instruments which 5 PAUL GF&AEOWSK‘I’
frequently appear in both modern orchestral and jazz music " TALES OF TIME AND SPACE \

such as the vibraphone, shaker and brass instruments — i
explain that while one would not see these instruments in
an orchestra of the baroque or classical period, romantic
and modern orchestras have increasingly used instruments

like these.

Wider listening

Discuss the idea of fusion: music of more than one style
blended together. Listen to Silverland by Paul Grabowsky
(available as an individual track from the iTunes store),
which itself is a fusion of funk, pop and jazz styles, and ask
the students to identify instruments they recognise from In
Search of a Comedy. Discuss the effect introducing new
tone colours into existing ensembles has.

Composition tasks
There are two tasks, depending on the level of the student
attempting them.

Cover artwork for Tales of Time and Space

The first task involves arranging a jazz groove for a larger
orchestration. Students open the file GrabTonel.sib and
decide which parts of the original arrangement might work
in an orchestra.

The second task involves
adding jazz elements to a
classical orchestral work, or
arranging a theme into a jazz
style. After opening Grab-
Tone2.sib, students can find
elements from the Ideas
Hub or they can write their
own.

Professional Development & Training

The intention of both tasks is
to mix the tone colours (and
styles to a certain extent) of
each genre to create a fusion
sound.
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9. Music Concepts and Composition Tasks: Texture

In Search of a comedy is a work that explores a wide range
of textures and textural devices.. How these work is easier
to see with empty staves hidden, and even easier with high-
lights applied to help reveal some of the textures and de-
vices Grabowsky works with. You can find this in the pro-
vided score called GrabColor.sib which you can print in
color by accessing the Sibelius panel of the print menu and
choosing View menu options (after making sure they're set
as you would like—highlights should be ticked) and Print in
color. To print in black and white, simply make sure those
choices are unticked.

Here are examples of some of the textural devices
Grabowsky explores:

Homophony

Homophony is usually considered as having two main incar-
nations. In the first, sometimes described as homophonic
homorhythm, all the parts are rhythmically identical. We can
hear this texture in the first two bars of the score ... and
only the first two bars

. - »

of the piece. bes of S8 ssee s of 55 EFELE
By G —  — o —— —Y e — ¢ wa

One of the important @4

repeating textures in

this work is a variation P . o o b = —» .

on homophonlc 7z A ) | I | ) 3 ; | I } Ill | | | 1

homorhythm  that 5‘}|/ [ vV ] =/ [ ry B

could be called
"homophonic h|gh- The first two bars of the piece
lighting.” Rather than having homophonic homorhythmic

parts, the supporting parts play only on

1’8 JuswdoldAs( JeuoIssajo.d

d oo . Cdebe . s .
certain notes of the melodic line, providing D E 5 prf pLebe Lo L 4, . P i
a sketchier version, like a children’s dot-to- 30 Vo § 67 ! —— o patm
dot puzzle. This texture gives a sound that N —
constantly moves from thick to thin to thick # P N Hn-aGM© U .o s .-l = e it Q
to thin, as in bars 29-30. TG 4 4 i ¥3 ; He S
r—— — — ; & . X ; N ; =
H . . PR s S | [ S U S | -
ere we have one instrument playing the 7 7 . oQ
melodic line and up to fourteen instrumen- ,
tal voices doing the homophonic 3z sass {2
L v e =
“highlighting” or “dot-to-dot” harmony. *E 7 )
Nice texture! But with Grabowsky, as you os [CF P $ a
might guess from, say, the intricacies of his i i — — = '
metric approach, it's not that simple. In b D 4, _ _ ] N ] )
bars 31-32 (see next page), he switches it Vil e e ¢ ¢ e
up, both by changing the timbre, and by N 4
having: wi |t D =% A S G A S A |
v’ 4 *= L #5_('
J One instrument playing the melodic w |18 e N
line . EE e S == ) g ¥
. . WS — ; is . N ,
o Three instruments playing homo- v | X L e T s S
- - L4
phonic homorhythmic harmony
P . it.; ; - . 2 b . - .
. . N DRSS S e S Ve X ) « X 5 4%
. One instrument playing homo- 3
phonic highlighting Bars 26 and 30
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LARINET

GLoce. { 1

R
.
)
R
Ra
[T
LY
e
n
Lol

) 7 ¥ 7 5 Fa T ¢ == b
Bars 31 to 32
The other type of homophony—with one melodic line and a
rhythmically separate "
harmony, often in 'i? £ :
longer chords—also CLARINET | = ’
figures briefly in the i 7 ,
00 piece, in bar 119. A0 = |
C yi
C This bar provides a o | 2 ;c |
) sharp contrast after . I~ === te 2}
— all the textural experi- 0.0 vioun {F5="0 ﬁ‘i?; . e ==——————————— |
— mentation and com- R ==
o plex interlocking ﬁ D
I parts that have char- stowsmmes(| * *%&
cC acterized most of the ==
GE) piece. iF2
Q_ Bar 119
(@) Ostinato
—
v .
nother textural device—one that Grabowsky uses a grea
> Another textural d that Grabowsky great
eal—is ostinato, a (more or less) stea ackgroun
8 deal tinat less) steady background
- against which all of the changes in the piece take place. This
can be seen clearly in the marimba part wi e repeat o
© b learly in th ba part with the repeat of
g this figure, which makes its first appearance in bar 3:
- and, most particularly, the shaker part, which is playe
A d t particularly, the shaker part, which is played
(D) (sometimes, you will not be surprised to learn, with a bit of
qa variation) through a good portion of the piece, after enter-
E ing in bar 5:
Pedal Tone / Drone The shaker part

A textural device that falls somewhere between a pedal
tone and a drone manifests for the first time in bars 9-12 in
the vibes:

]

g=—F & B P—————r 7

= 2 ==

Bars 9-12, vibes part

Variations appear, for example, at 33-36 in the horns and
vibes with some support from the flute; 57-64 in the slow
strings and vibes, with a genuine 8-bar drone on D in the
slow strings.
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Wider Listening

There is an instructional section in the Sibelius Worksheet
Creator that explores texture. You can find it here: 01 Ele-
ments of Music > 08 Score Analysis > 03 Textures & Tex-
tural Devices

Programme music is another interesting area in which to
explore texture. Just as the other elements of music change
to reflect the different parts of the story, so, too, do the tex-
tures.

To examine the use of texture in a large-scale work and
focusing on a sophisticated texture, you could listen to the
“thwarted” attempts to build a fugue in the scherzo move-
ment of Beethoven's Ninth Symphony, followed by the final
movement in which a double fugue plays a key role.

Composition task

Students will open the file GrabTexture.sib and write a
piece for piano (any other instrumentation in addition is
allowed) using at least three textures from those discussed
above and the list below.

Arpeggios
Broken chords
Canon

Reference to each performance technique is found in the
Ideas Hub to help the students remember what they have
learned in class.

The piece should be a theme and variations in which the
melodic (or main) material is explored by being arranged in
different ways, with different textural devices.
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10. Music Concepts and Composition Tasks: Structure

In Search of a Comedy is a challenge to analyse structurally:
it is more like a 1000-piece jigsaw puzzle than a piece that
can readily be described with A’s, B's, and C's. Sophisticated
students will be able to start with a full score and use stan-
dard signposts such as:

the main melodic material
meter changes
the soloist's part

to analyse the structure. The score GrabShortNoColor.sib
has the empty staves hidden, making the score easier to
work with (not to mention, saving trees).

If this is well within their capabilities, you could challenge
them to do the analysis entirely by ear (no score viewing),
but allowing them to listen to the piece (and portions of the
piece) using the mp3 as many times as they like.

Students who are not ready to take on the task from square
one can try one of these approaches:

. Start with the score called GrabShortColor.sib,
which has some textural devices coloured, giving
students a start for their analysis.

. For students who you want to help make the leap
from analysing simple compositions with limited
parts in their structure, you may wish to use the
score called GrabShortStructure.sib. This score has
an added stave called structure, with all other staves
hidden using Focus on Staves. On the structure stave
has been placed the material that is most likely to
help students understand the structure of the piece,
but with no verbal labels or analysis done. This tech-
nique has also reduced the score to 2 pages, making
it much easier for the less-experienced student to
grasp. The coloured highlights from GrabShort-
Color.sib have been retained, and these give a visual
indication of repetition, but they can be deleted if
you like.

Professional Development & Training

Composition Tasks

There are two tasks, depending on the level of the student
attempting them.

The first task involves using three captured Ideas to put a
piece together. The Ideas are taken from an actual piece of
music, a Contredanse for piano by Joseph Haydn, which can
be found in the Sibelius Worksheet Creator at this location:
03 Selected Repertoire > 02 Other Piano Repertoire > 09
Haydn > Contredanse. Students should not be introduced
to the piece prior to doing the task. They are asked to write
a brief paragraph describing the structure.

When students have completed their work, you may wish to
give them the opportunity to hear Contredanse in its origi-
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nal form (the score is included in this set), and compare
their work with Haydn's.

The second task asks students to create a piece with a com-
plex structure and invites them to use the Ideas feature to
hold chunks to make it easier for them to manipulate them
in the score. Before students begin this task, you may wish
to review with them the various features of the Ideas Hub.
Information can be found at 5.8 Ideas in the Sibelius Refer-
ence or earlier in this booklet.
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